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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for 
use with this EPSON scanner. EPSON is not responsible for any use of this information as applied to other 
scanners.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any 
options or any consumable products other than those designated as Original EPSON Products or EPSON 
Approved Products by SEIKO EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted Materials
Digital cameras and scanners, like photocopiers and conventional scanners, can be misused by improper copying of 
copyrighted material. While some countries’ laws permit limited copying of copyrighted material in certain 
circumstances, those circumstances may not be as broad as some people assume. EPSON encourages each user to 
be responsible and respectful of the copyright laws when using digital cameras and scanners.

Trademarks
EPSON and EPSON Stylus are registered trademarks of SEIKO EPSON CORPORATION. EPSON 
SoundAdvice is a service mark, ColorTrue is a registered trademark, and Perfection, Micro Step Drive, and 
EPSON FaxAdvice are trademarks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks. 

Copyright © 1999 by Epson America, Inc.  CPD 8876
8/99

 Printed on recycled paper with at least 10% post-consumer content.
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A Complete Scanning Solution

Your EPSON® Perfection™ 610 scanner is a high-quality scanner packed with 
easy-to-use features for scanning—for business, home, or school. The “plug & play” 
USB connection is fast and easy with no extra hardware to install. Using EPSON’s 
ColorTrue® Imaging System, the scanner captures your images with amazing detail 
and accurate colors. Your scanner can achieve up to 600 × 2400 dpi hardware 
resolution with EPSON’s proprietary Micro Step Drive™ technology, delivering 
crisp, precise images.

About Your Scanner

Your EPSON Perfection 610 scanner includes the following features:

■ Superior image quality:

■ True optical resolution of 600 dots per inch (dpi)

■ Hardware resolution of 600 × 2400 dpi with Micro Step Drive technology

■ Maximum resolution of 9600 × 9600 dpi with interpolation

■ Start button for easy, one-touch scanning

■ EPSON TWAIN for accurate, high speed scanning

■ Letter/A4 size scanning area

■ Self-adjusting lid that allows scanning of thick documents
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About Your Software

The EPSON Perfection 610 scanner includes these applications for great looking 
scans: 

About Your Documentation

This guide includes instructions for setting up your scanner, scanning tips, and 
troubleshooting advice. It also includes instructions for viewing your electronic 
manual. 

For details on using the scanner software, see your electronic EPSON TWAIN User’s 
Guide.

EPSON TWAIN Driver
The scanning utility for producing professional quality 
images. Ideal for scanning text into OCR programs.

PictureWorks™ HotShots™

Use this digital imaging software to get your images from the 
scanner and organize them right away. Then enhance your 
images, add special effects, and share them with photo 
templates and printouts.

BrØderbund ® The Print Shop® PressWriter™

Use the built-in templates to easily and quickly create 
professional newsletters, brochures, resumes, and flyers.

NewSoft™ Presto! ™ PageManager for EPSON
Use with the scanner’s Start button feature to quickly scan 
documents. Then drag and drop your scanned images into 
almost any application. Or convert scanned text into editable 
documents using the built-in OCR software.
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Cautions, Notes, and Tips

Please follow these guidelines as you read your documentation:

Cautions must be observed to avoid damage to your 
equipment.

Notes contain important information about your scanner.

Tips contain hints for great scanning.

System Requirements

The minimum system requirements for Windows and Macintosh are listed below. 
For optimum performance, a faster processor and more memory are recommended. If 
you are scanning high resolution images, you need more than the minimum available 
hard disk space listed.

Windows 98

■ An IBM® compatible PC with a 486/66 MHz or faster processor

■ Microsoft® Windows 98 preinstalled

■ 16MB RAM (32MB recommended)

■ 50MB available hard disk space

■ Available USB port or hub connection
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■ CD-ROM drive

■ Mouse or pointing device

■ VGA or higher resolution monitor with 640 × 480 resolution (800 × 600 or 
higher recommended) and 256 colors (65,000 colors or more recommended)

Color and tone reproduction are subject to the display 
capability of your computer system, including the video card, 
monitor, and software. See the documentation for these 
products for details.

Macintosh

You cannot use a serial interface to connect the scanner.

■ Apple® Macintosh® computer (G3 or iMac™) running Mac® OS 8.1, or 
Mac OS 8.5 or later 

If you are using Mac OS 8.1 on an iMac, you need to install 
iMac Firmware Update 1.0 before installing the scanner 
software. This is available online from the Apple web site. If 
you are using Mac OS 8.5, check the Apple web site for any 
updates.

■ Available USB port or hub connection

■ 32MB RAM (64MB recommended)

■ 50MB available hard disk space

■ CD-ROM drive

■ Mouse or pointing device

■ VGA color monitor with 640 × 480 screen resolution (or higher recommended) 
and 256 colors (32,000 colors or more recommended)

Color and tone reproduction are subject to the display 
capability of your computer system, including the video card, 
monitor, and software. See the documentation for these 
products for details.
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EPSON TWAIN supports the Apple ColorSync™ 2.X color management system and 
QuickTime.™ These extensions are automatically installed during EPSON TWAIN 
installation.

Year 2000 Ready

Your EPSON scanner is Year 2000 Ready. However, be sure the other parts of your 
computer system are also ready for the year 2000.

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that 
this product meets the ENERGY STAR guidelines for energy 
efficiency. The EPA ENERGY STAR office equipment program is a voluntary 
partnership with the computer and office equipment industry to promote the 
introduction of energy-efficient personal computers, monitors, printers, fax machines, 
and copiers in an effort to reduce air pollution caused by power generation.

Important Safety Instructions

Read all of these instructions and save them for later reference. Follow all warnings 
and instructions marked on the scanner.

■ Unplug the scanner before cleaning. Clean with a damp cloth only. Do not spill 
liquid on the scanner.

■ Do not place the scanner on an unstable surface or near a radiator or heat source.

■ Do not block or cover the openings in the scanner’s cabinet. Do not insert objects 
through the slots.
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■ Use only the type of power source indicated on the scanner’s label. 

■ Connect all equipment to properly grounded power outlets. Avoid using outlets 
on the same circuit as photocopiers or air control systems that regularly switch on 
and off.

■ Do not let the power cord become damaged or frayed.

■ Unplug the power cord if you will not be using the scanner for an extended period 
of time.

■ If you use an extension cord with the scanner, make sure the total ampere rating 
of the devices plugged into the extension cord does not exceed the cord’s ampere 
rating. Also, make sure the total ampere rating of all devices plugged into the wall 
outlet does not exceed the wall outlet’s ampere rating.

■ Do not attempt to service the scanner yourself. 

■ Unplug the scanner and refer servicing to qualified service personnel under the 
following conditions: 

If the power cord or plug is damaged; if liquid has entered the scanner; if the 
scanner has been dropped or the cabinet damaged; if the scanner does not operate 
normally or exhibits a distinct change in performance. Do not adjust controls that 
are not covered by the operating instructions. 
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Setting Up Your Scanner

Setting up your scanner is easy—just follow the simple steps in this book in the order 
listed below. 

1. Unpack and choose a place for your scanner.

2. Unlock the scanner.

3. Connect the scanner to your computer. 

4. Power on your system.

5. Install the scanner software. 

6. Install the creative software and view your electronic manuals.

Unpack Your Scanner

Remove the scanner from the box, then remove the packing material from your 
scanner. Save the packaging in case you need it later. Your EPSON Perfection 610 
comes with this Scanner Basics book and the items shown below.

scanner

CD-ROM with driver, 
electronic manuals, 
and creative softwareUSB interface cable
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Choose a Good Place for Your Scanner

Here are some points to consider:

■ Place the scanner on a flat, stable surface. If the scanner is tilted, it can’t operate 
properly.

■ Make sure to place the scanner where you can easily unplug the power cord, and 
where the USB cable can reach your computer.

■ Keep the scanner away from direct sunlight and strong light sources.

■ Avoid places subject to shocks and vibrations, or high or rapidly changing 
temperatures and humidity.

■ Be sure there’s enough room behind the scanner for the cables, and above the 
scanner so you can fully raise the document cover.

18.9 inches (48.0 cm)
when document 
cover is open

16.7 inches (42.5 cm)

3.5 inches (8.8 cm) 
when document 
cover is closed

11.3 inches (28.7 cm)

at least 
3.9 inches (10.0 cm)
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Unlock the Scanner

Before connecting the scanner to a power 
source, you must release the transportation 
lock, located on the side of the scanner.

Turn the transportation lock down to 
the unlocked position using a coin or 
similar object, as shown.

If you can’t turn the transportation lock 
easily, plug the scanner in; then, after a 
minute, unplug the scanner and try again.

Always lock the scanner carriage before transporting it; 
otherwise, the scanner may be damaged. Be sure the scanner 
lamp is in the home position (toward the back of the scanner). 
To ensure this, always unplug the scanner before locking the 
carriage.

home position
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Connect the Scanner to Your Computer

If you are connecting to a PC, Windows 98 must be preinstalled on your system.

1. Make sure the scanner is unplugged, and the computer and any USB devices 
connected to your computer are turned off. 

2. Locate the USB cable that came with your scanner.

3. Plug the square connector on the USB cable into the USB connector 
on the back of the scanner. Then plug the flat connector into the USB 
port on your computer or USB hub.

Your system may not work correctly if you use a USB cable 
other than the one supplied by EPSON or if you connect your 
scanner through more than one hub.

Power On Your System

Plug in your scanner before you turn on the computer. Otherwise, the computer may 
not recognize your EPSON scanner when you install your software. (The scanner 
lamp turns on when it is plugged in, but goes into sleep mode when it has not been 
used for ten minutes. The lamp comes back on when you scan.)

It is recommended that you unplug your scanner when you are 
not using it.
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Install the Scanner Software

The scanner software comes on one CD-ROM for both Windows 98 and Macintosh.

If You’re Running Windows 98 . . .

You may be asked to insert your Windows 98 operating system CD-ROM during the 
scanner installation. Have your Windows CD-ROM handy, in case you need it.

1. Make sure your scanner is 
plugged in to a power source and 
connected to the computer; then 
turn on your computer. 

A screen appears saying that your 
system has detected new 
hardware. Then the Add New 
Hardware Wizard screen appears.

2. Insert the scanner software 
CD-ROM in the CD-ROM 
drive, then click Next. 

3. Select the Search for the best 
driver for your device option, 
then click Next.
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4. Make sure only the CD-ROM drive 
check box is selected, then click 
Next. 

5. Click Next to continue with the 
driver installation.

6. After the scanner software 
installation is complete, the EPSON 
Screen Calibration utility 
automatically starts. You must 
calibrate your screen and scanner to 
reproduce images closely matching 
the originals.

You don’t need to change the screen calibration again so long 
as you continue to use the same monitor. If you need to 
recalibrate your screen at a later time, click Scanners and 
Cameras in the Control Panel. On the Devices tab, select 
Scanner. Click Properties, then click the Calibration button.

basics.book  Page 12  Wednesday, August 11, 1999  2:26 PM



13

In the following window, move the slider to the right or left until the shades of the 
horizontal gray stripes appear similar. View the screen from a short distance. The 
gray stripes will not perfectly blend together; however, try to make the two tones 
match as closely as possible.

7. Click OK to register the calibration setting.

8. Click Finish to exit the Add New 
Hardware Wizard.

You will find the Scanners and Cameras icon in the 
Control Panel after EPSON TWAIN is installed.

9. Now you can install your creative software and view your electronic manuals as 
described on page 16.

before calibration after calibration
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If You’re Using a Macintosh . . .

If you are using Mac OS 8.1, you need to install the Macintosh 
Update before installing the scanner software. This is available 
online from the Apple web site. If you are using Mac OS 8.5 or 
later, check the Apple web site for any updates. 

1. Make sure your scanner is plugged in to a power source and connected to the 
computer. Then turn on your Macintosh and turn off any virus protection 
programs.

If you see the following message, click OK and continue with step 2.

2. Insert the scanner software CD-ROM in the CD-ROM drive. Double-click the 
EPSON CD-ROM icon to open it.

3. Double-click the  EPSON TWAIN L Installer icon.

4. The EPSON screen and software License Agreement screen appear. After reading 
the license agreement, click AGREE to continue with the installation. 

5. When the Scanner Software Installation screen appears, click Install.

6. When the EPSON TWAIN Installer screen appears, click Install for the default 
installation.
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7. When the scanner software installation is 
complete, you see this screen: 

Click Quit. The Screen Calibration utility starts. You must calibrate your screen 
and scanner to reproduce images closely matching the originals. 

8. In the following window, move the slider to the right or left until the shades of the 
horizontal gray stripes appear similar. View the screen from a short distance. The 
gray stripes will not perfectly blend together; however, try to make the two tones 
match as closely as possible.

9. Click OK to register the calibration setting. Then restart your Macintosh. 

You will not need to change the screen calibration again as 
long as you continue to use the same monitor. If you need 
to recalibrate your screen at a later time, select Screen 
Calibration in the EPSON Scanner folder.

10. Now you can install your creative software and view your electronic manuals as 
described below.

before calibration after calibration
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Install the Creative Software and Electronic 
Manuals

Before you begin, Be sure any virus protection programs are turned off. Follow these 
steps:

1. Insert the scanner software CD-ROM in your CD-ROM drive.

2. Windows: Double-click My 
Computer, then double-click the 
CD-ROM icon. The CD-ROM 
window opens. Double-click

 EPSON.exe.

Macintosh: Double-click the EPSON 
CD-ROM icon to open it, if necessary, 
then double-click the EPSON icon.

3. The EPSON screen and software 
License Agreement screen appear. After 
reading the license agreement, click AGREE to continue with the installation. 

The Main Menu appears on your 
screen.
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4. Click Creative Software. The 
Creative Software screen appears. 

5. Click the application name or button 
for the program you want to install. 

The install screen appears for the 
application you selected (the example 
shown is for PictureWorks HotShots.)

6. Click the Install text to install the 
selected software. (You can skip the 
installation by clicking the BACK 
button at the bottom of the window.)

7. If the application requires a restart, go back to step 2 after restarting to install 
another application. If the application does not require a restart, you return to the 
Creative Software screen. Select another application to install or click BACK to 
return to the Main Menu.

8. After you install your applications you can view and install your electronic 
manuals. At the Main Menu, click Electronic Documentation.

9. On the Electronic Documentation screen, click the name of the manual you want 
to view. If you don’t have Adobe Acrobat Reader 4.0 or 3.0 installed, you have the 
option to install it from the CD-ROM. For more information, see “Viewing Your 
Electronic Manuals” on page 19.

10. If you install Acrobat Reader on your Macintosh, you need to restart the 
computer. To get back to the Main Menu, double-click the  EPSON 
Installer icon.
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11. After viewing an electronic manual, close Acrobat Reader and click the Electronic 
Documentation window to highlight it. You can select another manual to view, 
click BACK to return to the Main Menu, or click QUIT or EXIT to quit the 
installer.

If any of the software you installed requires a restart and you 
did not restart when you installed the software, you should 
restart your computer now.
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Viewing Your Electronic Manuals

You always have easy access to your electronic manuals—just go to the Main Menu 
screen on your scanner software CD-ROM and click Electronic Documentation. If 
you already have Adobe Acrobat Reader (version 3.0 or later) on your system, the 
manual opens in Acrobat Reader automatically. If you don’t have Acrobat Reader, it is 
automatically installed from the CD-ROM and then the manual you selected opens.

Your scanner software CD-ROM includes the following manuals:

■ EPSON TWAIN User’s Guide (TWAIN.pdf)

■ PictureWorks HotShots User’s Guide (HotShots.pdf)

■ NewSoft Presto! PageManager User’s Guide (PageManager.pdf)

■ BrØderbund The Print Shop PressWriter User’s Guide (PressWriter.pdf)

For guidelines on viewing your electronic manuals using Acrobat Reader, see 
“Navigating a Manual” on the next page. 

Copying a Manual to Your Hard Drive

If you prefer to view the electronic manuals from your hard drive instead of the 
CD-ROM, you can copy them from the Manuals folder, located in the Browser 
folder on the CD-ROM. The file names are listed above. 

The manuals for some software applications are automatically 
copied to your hard drive when you install the software. You 
can access these manuals by clicking Start, Programs, the 
program name, then the manual name.
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Navigating a Manual

When you open an electronic manual, you’ll see this toolbar:

The toolbar for Acrobat Reader 3.0 looks slightly different.

With Acrobat Reader, you have several ways to navigate through text:

■ Click on hot topics, which are usually underlined or displayed in a different color. 
To find out if a topic is hot, move your cursor over it. If the cursor turns into a 
pointing hand, the topic is hot—you can jump to it by clicking once.

■ Use the bookmark section on the left side of the screen to move quickly to the 
topic of your choice. Click the Show Bookmarks icon on the toolbar to see the 
bookmark section, if the manual has bookmarks. Some manuals only have a table 
of contents, but you can also use this to navigate the manual if the topics are hot.

■ Use the arrow buttons in the toolbar or the vertical scroll bar on the right side of 
the document to move through a manual. (The box to the left of the scroll bar 
displays the current page number.)

For more information, see your Acrobat Reader online guide.

first page

previous page next page

last page

show bookmarks and page
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How to Scan

This section gives you an overview of the scanning process and some tips for getting 
the best scan. It also includes step-by-step scanning instructions.

Preparing to Scan

Scanning an image allows you to reproduce it many times with little or no loss of 
quality. You can also enlarge, reduce, or change the color of the image without 
affecting your original.

Scans are performed from within a host application (the application into which you 
plan to import the scanned image or document, such as PictureWorks HotShots). 
You have to start this application before you can access your scanner software. Once 
you’ve started your application, you need to select the scanner “source” you want to 
scan with. Your EPSON Perfection 610 scanner comes with the EPSON TWAIN 
driver. You need to select this driver as the source in your application.

Selecting Your Application for Scanning

You need to select the appropriate application for what you are scanning. Some 
examples of scans are shown in the following table. 

Image type Recommended application

Photograph HotShots

Small photograph to be enlarged HotShots

Magazine HotShots

Newspaper (text only) PageManager

Text for OCR PageManager

Text with images (not for OCR) HotShots

Line art HotShots
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Step-by-Step Scanning Instructions

This section contains step-by-step instructions for using the scanner drivers and 
creative software in Windows 98 and Macintosh. For more details on using the 
scanner software, see the EPSON TWAIN User’s Guide on your CD-ROM. For 
instructions on using the creative software, see your application’s online help or 
electronic manual (see “Viewing Your Electronic Manuals” on page 19).

If your computer fails to recognize the scanner, you won’t see 
the EPSON TWAIN driver when you try to select a scanner 
source from your host application. In addition, an error 
message may appear. If this happens, unplug your scanner 
and then plug it back in. Then restart the computer.

Do not connect or disconnect the USB cable while you are 
using EPSON TWAIN.

Place Your Original Document

1. Raise the scanner cover and place your 
document face down on the document 
table glass.

2. Position the document so the horizontal 
and vertical edges are carefully aligned with 
the scales on the top and right side of the 
document table.

3. Close the document cover slowly. Be 
careful not to move the document.

An area of 0.12 inches (3 mm) in from the horizontal and 
vertical guides is not scanned.

The self-adjusting scanner cover allows you to place thick 
documents on the document table glass without removing it. 
If your document is too thick to fit under the cover, you can 
remove the cover as described on page 29.

corner of the 
document
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Scan a Photograph with PictureWorks HotShots 
and EPSON TWAIN

This example explains how to scan a photograph using the EPSON TWAIN scanner 
driver and PictureWorks HotShots. To scan an OCR document using the Start 
button and Presto! PageManager, see “Start Button Scanning” on page 31. For 
additional information on how to use EPSON TWAIN, see the electronic EPSON 
TWAIN User’s Guide. 

Make sure you have placed your document as described above and your computer is 
turned on, then:

1. Click Start, point to Programs and PictureWorks, then click HotShots 1.5.

2. Select your scanner source and open the scanner software (EPSON TWAIN):

a. Click the Get button.

b. Select Get from Scanner.

c. Click the Select Scanner menu.

d. Select EPSON TWAIN L from the list.

e. Click Get Pictures Now.

f. Select Open Them, Add to New Collection, or 
Add to Existing Collection from the Get Pictures 
dialog box.

3. Make the appropriate setting selections for your scan. (See page 24 for details.)

4. Preview your scan. You see a preview of your scan in the preview area on the right 
side of your screen. (You may need to click Preview to update the image.)

5. Draw a marquee around the part of the image you want to scan.

Make sure you draw a marquee around only the part of the 
image you want to scan, especially if you are scanning at 
resolutions of 300 dpi or greater. See page 26 for details.

6. Make the changes you want to adjust the image, then click the Scan button to 
scan your image.

Get button
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In a few moments, the scanned image is imported into PictureWorks HotShots. You 
must close EPSON TWAIN to view the image in the application window.

Don’t leave documents, especially photographs, on the 
document table for long periods of time. They may stick to the 
glass or deteriorate from the warmth of the scanner.

Selecting Settings

For Photographs

If you are scanning a photograph or images other than line art or text, you should scan 
using the Photo tab. You should also use this tab for pages with both text and photos.

Select from the settings below:

■ Image Type: Color Photo, Black & White Photo

■ Resolution: 75, 150, 300, 600, 1200, 2400

■ Color Management: Speed, Quality
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■ Effect: Unsharp Mask, Descreening

For Line Art and Text

If you are scanning line art or text, you should scan using the OCR/Line Art tab. 

Select from the settings below:

■ Resolution: 300, 600

■ Threshold: User Defined, Newspaper, Magazine, Printout, Book

If you are scanning text for OCR, you should use PageManager. See page 31 for a 
step-by-step example of how to use the Start Button, PageManager, and HotShots to 
create an illustrated, editable document.

For more information on EPSON TWAIN and PageManager, see your electronic 
EPSON TWAIN User’s Guide.
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Using Marquees

A marquee is a frame around an entire image, or a portion of an image so you can scan 
only the most important part. To create a marquee, follow these steps:

1. Move the mouse pointer over the preview image; the pointer becomes a cross hair. 

If the mouse pointer doesn’t change to a cross hair, click the 
Preview button again.

2. Position the pointer in the corner of the area you want to select and press the 
mouse button.

3. Hold down the mouse button as you drag the mouse across the image, creating a 
marquee. 

4. Release the button when the marquee contains the image area you want.

5. When you’re ready to scan, click the Scan button. The scanned image appears in 
your application window.

If you need to adjust the marquee size or position, or delete the marquee, see page 27.

marquee
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Adjusting a Marquee

To resize a marquee, place the mouse pointer over its edge; the 
pointer changes to a double-headed arrow. Click the mouse 
button and drag the box up, down, sideways, or diagonally to 
the size you want. 

To resize a marquee and retain its width-to-height proportions, 
hold down the Shift key as you drag the edge of the marquee.

To move a marquee, place the mouse pointer anywhere in the 
marquee image area; the pointer changes to a hand. Click the 
mouse button and drag the entire marquee to move it where you 
want it.

To delete a marquee, click outside the marquee area. 

Tips for Getting the Best Scan

Getting the best scan possible depends on several factors, including the quality of your 
original and the resolution you select. The better your original is, the better your scan 
will be. While you can make some corrections in your scanning software, you’ll need 
to do major photo retouching in a program such as PictureWorks HotShots to correct 
or mask problems such as a coffee stain on the original image.

Selecting Resolution

Resolution refers to how many dots per inch (dpi) or dots per centimeter (dpcm) your 
image contains. The best resolution for a scanned image depends on the type of image 
you’re scanning and your final output device.

As a rule of thumb for most images except line art, use a scanning resolution that is 
approximately one third of your output resolution. For example, use a scanning 
resolution up to 100 dpi with a 300 dpi laser printer, and up to 200 dpi with a 

basics.book  Page 27  Wednesday, August 11, 1999  2:26 PM



28

600 dpi laser printer. For 1440 dpi ink jet printers, such as the EPSON Stylus® 
COLOR or Photo series, use a scanning resolution of approximately 300 dpi. Try a 
scanning resolution of 240 dpi for 720 dpi printing.

Keep the following in mind when you choose a resolution:

■ The higher a resolution you select, the larger the resulting image file will be. For 
example, an 8.5 × 11-inch original scanned at 300 dpi can produce a 24MB file. 
The same original scanned at 72 dpi creates only a 1.3MB file. To keep your file 
size manageable, select the lowest possible resolution that gives acceptable quality.

■ If you need to scan at a higher resolution, you can reduce the size of the image file 
by scanning only part of the image. For information about selecting part of an 
image, see “Using Marquees” on page 26.

■ If you will be enlarging a file in your image editing software, scan at a higher 
resolution to maintain the image quality.

The EPSON Perfection 610’s maximum hardware resolution of 600 × 2400 dpi is 
achieved through EPSON’s advanced Micro Step Drive technology. This technology 
enables the EPSON Perfection 610 to achieve a maximum sub-scan or vertical 
resolution of 1200 dpi or 2400 dpi using “half-stepping” and “quarter-stepping” of 
the scanning carriage to double and quadruple the optical resolution. To prevent 
enormous file sizes when scanning at the maximum hardware resolution, EPSON 
recommends a maximum scan window of 4 × 11.7 inches. Full 8.5 × 11.7 inch 
scanning is available at a sub-scan resolution of 1200 dpi or 9600 dpi interpolated.
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Scanning Something That Doesn’t Fit 
Under the Document Cover

The self-adjusting scanner cover allows you to 
place thick documents on the document table 
glass without removing the cover. If your 
document is too thick to fit under the cover—
such as a photo in an album—you can remove 
the document cover. To do this, simply lift 
the back of the document cover straight up.

When scanning with the cover removed, make sure no area of the document table is 
exposed. This prevents interference from external light.

When reattaching the document 
cover, be sure to hold the cover 
so the hinges are in a vertical 
position. Then push straight 
down until the cover clicks into 
place.

basics.book  Page 29  Wednesday, August 11, 1999  2:26 PM



30

basics.book  Page 30  Wednesday, August 11, 1999  2:26 PM



31

Start Button Scanning

The scanner’s Start button lets you set up your system for one-touch scanning with 
Presto! PageManager and a scanner monitoring utility. With one-touch scanning, you 
can load a document in the scanner, press the Start button, and watch while 
PageManager starts and then opens EPSON TWAIN automatically.

This chapter includes a scan project that demonstrates how to:

■ Use the Start button for quick scanning

■ Run drag-and-drop OCR with PageManager and your word processing 
application

■ Drag-and-drop an image from your imaging software into the document

Preparing to Use the Start Button

To use the Start button, you must have installed PageManager (see page 16). With 
Windows 98, you can also use other programs that support linking to scanner events 
with the Start button, such as Adobe® Photoshop® 5.0 and Windows Imaging. If you 
want to configure specific settings for Start button scanning, see your electronic 
EPSON TWAIN User’s Guide.

When you’re ready to use the Start button, follow the instructions in “Creating an 
Illustrated Document” on page 32.

basics.book  Page 31  Wednesday, August 11, 1999  2:26 PM



32

Creating an Illustrated Document

This section gives an example of how to use the Start button to scan a document, use 
the PageManager OCR (optical character recognition) engine to convert it to an 
editable document in your word processor, and then drag in a scanned image into 
your document. The steps use Microsoft Word, but you can use any OCR-compliant 
program. The example also uses PictureWorks HotShots; see page 16 for installation.

Follow these steps to create a simple illustrated document:

1. Place the document face down and align its horizontal and vertical edges with the 
scales on the top and right side of the document table.

2. Press the scanner’s Start button.

Start button
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3. In Windows, if you’ve selected more than one application to use with the Start 
button in the Scan Events utility, you see this dialog box:

For instructions on changing the applications available for use 
with the Start button, see your electronic EPSON TWAIN 
User’s Guide.

4. Click Presto! PageManager for EPSON and click OK. (If the dialog box 
disappears before you select an application, press the scanner’s Start button again.)

If PageManager wasn’t running when you pressed the Start button, it starts on 
your system. The EPSON TWAIN window opens in PageManager, along with 
the Scan Buttons bar. 
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5. To scan a document for an OCR application, select the OCR/Line Art tab. (See 
page 24 for other TWAIN settings you may want to select.)

6. Click the Scan button to scan your document.

When scanning is finished, click the Close button to close the EPSON TWAIN 
window.

7. Click the Inbox icon to view the image icons in PageManager.

click and drag the 
image thumbnail 
to your 
application’s icon

selected image 
thumbnail

click the inbox 
icon to view 
thumbnails

basics.book  Page 34  Wednesday, August 11, 1999  2:26 PM



35

8. Drag the thumbnail of the image from the main window to your application’s 
icon on the application bar.

The OCR window opens, showing the progress of the 
translation.

When the text is converted, the application automatically 
opens with your new file.

9. Save the new file in your application and close PageManager.

10. Open PictureWorks HotShots and then open an image or collection. (If you 
want, scan a new image following steps 1 to 9 above, selecting the Photo tab in 
step 5 and dragging the file to the HotShots icon in step 8.)
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11. Arrange the window for HotShots so it is next to the window for your application.

12. Click the image you want to copy from the HotShots collection, or click the gray 
bar at the top of your open image.

13. While holding down the mouse button, drag the image to the location where you 
want it in your document.

14. Release the mouse button. The picture appears in your document in the other 
application.

You can also configure your system and PageManager to automatically launch an 
application and scan directly into it using the Start button. See your EPSON TWAIN 
User’s Guide for more information.

basics.book  Page 36  Wednesday, August 11, 1999  2:26 PM



37

Working With Scanned Photos

This chapter steps you through what you can do with your image once you have 
scanned it into your computer using PictureWorks HotShots. The following 
information is covered in this chapter:

■ Opening an image and placing it in a collection

■ Correcting images

■ Printing

■ Adding your image to a document

Opening a Picture and Placing It In a 
Collection

You may have saved your picture in a HotShots collection when you 
scanned it. If you didn’t, or if you want to save it in a different 
collection, follow these steps to open your picture and create a new 
collection:

Open the Picture

1. Open HotShots and click the Get button on the remote control.

2. Select Get from Disk and click the Open a Picture button. (You 
can also select Open Picture from the File menu.)

3. You see the Open dialog box. Highlight the picture name and 
click Open. Your picture opens in a window.

Get button
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Open or Create a Collection

1. Click the Get button on the remote control.

2. Click Get from Disk and click the Open a Collection or Create a Collection 
button.

3. You see the Open dialog box. Highlight an existing collection and click Open, or 
click Empty to open a new collection. Your collection window opens.

Add Pictures to the Collection

There are two ways to add pictures to your collection: drag-and-drop or the Add 
button.

To drag and drop a picture into a collection, open the picture and collection, as 
described in the previous sections. Then click the gray grab bar on the picture, drag it 
to the collection window, and release the mouse button. The picture appears in the 
collection window.

To add an unopened picture, click the Add button on the taskbar in the collection 
window. You see the Add to Collection dialog box. Select the picture you want to add 
and click Add (Windows) or Open (Macintosh). The picture appears in the collection 
window.

Click the gray 
grab bar,
then drag it to the 
collection 
window

Add 
button
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Delete Pictures From the Collection

To delete a picture from a collection, click it; a green line appears around the picture. 
To select multiple pictures for deletion, hold down the Ctrl (Windows only) or Shift 
key as you click the pictures. Then click the Delete button. You see a confirmation 
message; click Yes.

Correcting Images

The following sections describe three ways you can optimize your image quality in 
HotShots:

■ Using Quick Fix

■ Using SmartPix

■ Using Fix by Example

Using Quick Fix

The easiest way to enhance your image is to use HotShot’s Quick Fix command to 
automatically adjust it. Quick Fix gives you clearer, brighter images while maintaining 
the highlight and shadow detail. However, if your original image has intense 
highlights or shadows, it’s better to adjust it using Fix by Example, as described on 
page 42.

Selected 
image

Click the Delete 
button to delete 
an image

basics.book  Page 39  Wednesday, August 11, 1999  2:26 PM



40

Follow these steps to use Quick Fix:

1. Open the picture you want to edit. See page 37 for instructions.

2. Click the Enhance button on the remote control to open the 
Enhance menu.

3. Click Quick Fix. The picture in the window is modified to reflect 
your changes. (You can zoom into the image to see the changes 
more clearly; click Zoom In from the Image menu.) 

If you change your mind about the edit, select Undo from the 
Edit menu.

4. To save your edited picture, select Save As from the File menu. 
Be sure to give your picture a new name, if you want to save the 
original picture as it was. Then click Save.

Using SmartPix

HotShots’ SmartPix feature lets you optimize your image quality based on these 
characteristics:

■ The device you used to capture the image (Internet, camera, scanner, or other 
device)

■ Whether the photo was taken inside or outside

■ The lighting conditions under which the photo was taken

SmartPix uses device profiles built into the HotShots program to determine the level 
and type of corrections to make your image. To experiment with corrections, you can 
use SmartPix multiple times to “layer” the effects, if you like.

Follow these steps to use SmartPix:

1. Open the picture you want to edit. See page 37 for instructions.

2. Click the Enhance button on the remote control to open the Enhance menu.

Enhance button
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3. Click SmartPix. You see the SmartPix editing window.

4. If the portion of the picture shown in the example area is too small or you want to 
see a different example area, click and drag the example area selector to choose a 
new area. Drag the edges of the selector to enlarge the area; drag the middle of the 
selector to reposition it.

5. Click the arrow in the device pull-down list and select the type of device used to 
capture your photo: Camera, Internet, Scanner, or Other Device.

6. Select the location where the picture was taken, either inside or outside.

7. Select the lighting conditions under which the photo was taken. If you chose 
inside, select with a flash, fluorescent lighting, shadows, or faded colors. If you 
chose outside, select sunny day, cloudy day, some shadows, lots of shadows, 
or faded colors.

8. The effects of your selections in steps 5 through 7 are shown in the With Changes 
example in the SmartPix window. Remember, you can layer changes over 
previous changes—such as sunny day and some shadows—to get the effect you 
want.

9. If you don’t like the results, click Cancel Changes at the bottom of the remote 
control. 

To keep your changes and return to the main HotShots window, click Done. 

Device 
pull-down list

Example area 
selector
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You can still cancel your SmartPix changes by selecting Undo from the Edit 
menu.

10. To save your edited picture, click Save As from the File menu. Be sure to give 
your picture a new name, if you want to save the original picture as it was. Then 
click Save.

Using Fix by Example

HotShots’ Fix By Example feature lets you make a series of corrections to a picture’s 
brightness, intensity, color tint, and sharpness by selecting from on-screen examples.

Follow these steps to use Fix By Example:

1. Open the picture you want to edit. See page 37 for instructions.

2. Click the Enhance button on the remote control to open the Enhance menu.

3. Click Fix By Example. You see the By Example editing window:

4. Click the characteristic you want to correct: Brightness, Intensity, Color Tint, or 
Sharpness. 

The key example in the center represents the original image. The surrounding 
eight examples indicate varying corrections of the characteristic.
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To adjust the amount of variation shown in the examples, slide the variation slider 
on the remote control to the right or left.

5. Click the example that looks best to you; that example moves to the center and 
the surrounding examples adjust to reflect less or more correction proportionately. 
Click an example as many times as you wish to get the results you want. (To undo 
the change you made, click Reset on the remote control.)

6. To adjust a different image characteristic, repeat steps 4 and 5 to further correct 
the image.

7. Once the With Changes and Zoomed Changes images look how you want them 
to, click Done to keep your changes and exit to the HotShots main window. (To 
undo the changes you made, click Cancel Changes.)

If you change your mind about the edit, select Undo from the Edit menu.

8. To save your edited picture, select Save As from the File menu. Be sure to give 
your picture a new name, if you want to save the original picture as it was. Then 
click Save.

Printing

The steps in this section describe how to place your image in a creative template 
(photo page) and print it. If you don’t want to use a photo page, skip to “Printing 
Your Image or Photo Page” on page 45.
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Creating a Photo Page

Follow these steps to place your image in a colorful template for 
printing:

1. Open the image you want to print. See page 37 for instructions.

2. Click Share on the remote control to open the Share menu. 
Then select Make Photo Page from the menu.

3. Select a category of Photo Page templates you’d like to use, such 
as Awards, Holidays, or Events. The available Photo Pages for 
the category appear in the list below the category.

4. To view the Photo Page choices, click the up or down arrow in 
the list. When you find the Photo Page you want, click it. A 
Photo Page window opens.

5. Arrange the Photo Page window and your picture or collection 
window so you can see them both.

Share button

Click the gray bar in an open image Click the center of an image in a collection

Then hold down the mouse 
button and drag the picture to 
the image area in the photo 
page

or
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6. To import your picture into your photo page, place the mouse cursor in the gray 
bar between the image and the title bar (or in the center of an image in a 
collection); the cursor changes to a hand. Click and drag the picture to a Photo 
Page import area; then release the mouse button.

To delete a picture from the import area, select Undo from the Edit menu (if you 
just added it), or drag a new image to the import area to replace it.

Printing Your Image or Photo Page

Follow these steps to print:

1. Select Print Pictures from the Share menu on the remote control.

2. Select the size at which you want to print your picture, as described in the 
following table.

3. Select the number of copies of your picture you want printed on one page: either 
1 per page or Fill Page.

4. Follow the instructions for your operating system to select your print settings:

Windows: Select Printer Setup at the bottom of the Share menu on the remote 
control. (You can also select Printer Setup from the File menu.) Make sure your 
printer is selected and click the Properties button.

Select the print settings for your printer, making sure to select the correct paper 
size setting. (See your printer manual for instructions.) When you return to the 
Printer Setup dialog box, click OK.

Size setting Description

Wallet size 2 × 3 inches (5.08 × 7.62 cm)

3 × 5 7.62 × 12.70 cm

4 × 6 10.16 × 15.24 cm

5 × 7 12.70 × 17.78 cm

Fit to page Prints as large as possible on the paper 
size you select in your print settings
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Select Print It Now from the bottom of the Share menu. You see the Print dialog 
box. The number of picture copies that will print on the page is shown in the 
Print dialog box. 

Macintosh: Select Page Setup at the bottom of the Share menu on the remote 
control. (You can also select Page Setup from the File menu.)

Select some of the print settings for your printer, making sure to select the correct 
paper size setting. (See your printer manual for instructions.)

Select Print It Now from the bottom of the Share menu. You see the Print dialog 
box. Select the rest of your print settings. The number of picture copies that will 
print on the page is shown in the Print dialog box.

5. Click OK (Windows) or Print (Macintosh) to print your picture.

Adding Your Image to a Document

You can add your image to a document by importing, copying and pasting, or by 
dragging and dropping it.

Importing Images Into Documents

Once your pictures are scanned and saved on your hard drive, you can import them 
into your applications. If your application can’t import the file type that you have 
saved your images in, you can use the Save As feature of HotShots to convert them. 

Follow these steps to import a picture into your document:

1. Start your word processor or other application.

2. Open the document in which you want to use the picture.

3. Select the point where you want to place your picture.
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4. Select Picture from the Insert 
menu, then select From File. 
(In some applications, you 
may need to select a different 
command, such as Import 
Picture, which is usually in the 
File menu.) A file selection 
dialog box appears.

5. Locate and select the image you want to insert. In some applications you can see a 
preview of your picture.

6. Click OK (or Insert, Import, or 
whatever command your 
application uses) to insert your 
picture. The picture appears in 
your document.

Getting Images With Copy and Paste

You can use this method to place a picture in just about any type of document or 
project. Follow these steps:

1. Open your picture in HotShots; see page 37 for instructions.
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2. From the Edit menu, click Select All. A dotted 
border appears around your picture.

3. Select Copy from the Edit menu.

4. Start your word processor or other application.

5. Open the document in which you want to use 
the picture.

6. Select the point where you want to place the 
picture.

7. Choose Paste (or Paste Special) from the Edit menu. A copy of the picture 
appears in your document.

Using Drag and Drop From a Collection

Once you have transferred your pictures into HotShots collections, you can easily 
drag and drop them into your documents. (For more information on using 
collections, see page 38.)

Dragging and dropping an image into a document works only 
with OLE-2.0-compliant applications, such as Microsoft Word, 
PowerPoint, WordPerfect, or Lotus SmartSuite. Depending on 
how well your application supports OLE 2.0, your images may 
not look as good when you drag and drop them as when you 
import them.

Follow these steps:

1. Start HotShots.

2. Click Get on the remote control to open the Get menu, 
if necessary. Then select Get from Disk.

3. Click the Open a Collection button. You see the Open 
dialog box.

4. Locate the collection you want and double-click the 
collection name to open it.

Get button
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5. Start your word processor or other application.

6. Open the document in which you want to use the picture. Arrange the window 
for HotShots so it is next to the window for your application.

7. Click the image you want to copy from the HotShots collection. 

8. While holding down the mouse button, drag the image to the location where you 
want it in your document. (You may need to create a frame to place the image 
exactly where you want it; see your application’s documentation.)

9. Release the mouse button. The picture appears in your document in the other 
application.
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Scanner Maintenance

This chapter tells you how to transport your scanner safely and gives you basic 
maintenance instructions.

Transporting the 
Scanner

When you transport the scanner a long distance 
or store it for an extended time, follow the steps 
below to secure the carriage.

1. Plug in the scanner and wait until the 
carriage moves to the home position 
(toward the back of the scanner). 
Then unplug the scanner.

If the carriage does not automatically return to the home 
position, slowly raise the front of the scanner and hold it up 
until the carriage comes to rest in the home position. Then 
turn the transportation lock to the locked position.

2. Use a coin or screwdriver to turn the 
transportation lock to the locked 
position (toward the top of the 
scanner).

home position
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Cleaning the Scanner

To keep your scanner operating at its best, you should clean it periodically. Before 
cleaning, unplug the power cord.

Use a soft cloth to clean the outer case with mild detergent dissolved in water.

If the document table glass gets dirty, clean it with a soft, dry cloth. If the glass is 
stained with grease or other hard-to-remove material, use a small amount of glass 
cleaner on a soft cloth to remove it. Wipe off any remaining liquid with a dry cloth.

Be sure there’s no dust on your document table. Dust can cause white spots to appear 
in your scanned image.

Never use a harsh or abrasive brush or cleaning product to 
clean the document table. A damaged glass surface can 
decrease the scanning quality.

Never use alcohol, thinner, or corrosive solvent to clean the 
scanner. These chemicals can damage the scanner 
components as well as the case.

Be careful not to spill liquid into the scanner mechanism or 
electronic components. This could permanently damage 
them.

Don’t spray lubricants inside the scanner.

Never open the scanner case. If you think repairs or 
adjustments are necessary, consult your dealer or contact 
EPSON.
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Problems? Need Help?

This chapter identifies the scanner parts and gives you the basics for diagnosing and 
solving scanner problems. For solutions to common setup and software problems, see 
“Problem Solving” on page 54.

For more troubleshooting tips, see the “Troubleshooting” section of your electronic 
EPSON TWAIN User’s Guide.

Identifying Scanner Parts

Here are the parts of your scanner:

carriage and lamp
(in the home position)

document 
table

Start button

transportation 
lock

document cover

USB interface 
connector

AC inlet

back view
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Scanner Lamp Error Indication

If an error occurs, the scanner stops and its lamp shows the type of error.

The scanner turns the fluorescent lamp off if it does not 
receive commands from EPSON TWAIN within ten minutes.

Problem Solving

If you’re having problems, this section answers some of the most common questions. 

Operating Problems

Problems you may have while using the scanner often involve the operation of your 
software and computer. Operation problems usually occur because of:

■ Incorrect setup of your computer or software

■ Incorrect operation of your software

■ Inappropriate selection of the scanner software settings

Lamp activity Explanation

Rapidly flashing The scanner is not connected properly. Check the USB 
connection and unplug the scanner. Wait at least ten 
seconds, then plug the scanner in again.

The transportation lock is not released or the scanner is 
broken. Make sure the transportation lock is in the 
unlocked position. Then unplug the scanner, wait at least 
ten seconds, then plug it in again. If the scanner still does 
not operate correctly, or if the error occurs repeatedly, 
consult your dealer.

Off The lamp is burned out. Consult your dealer to get a 
replacement lamp.

basics.book  Page 54  Wednesday, August 11, 1999  2:26 PM



55

Also see the documentation that came with your computer and printer for possible 
solutions.

Setup Problems

If your system doesn’t recognize the scanner . . .

■ Make sure your scanner is plugged in. If you opened your host application before 
you plugged in your scanner, close your application and reopen it.

■ Check the USB cable connection or try using another USB cable.

■ If you get the message, “No push button scanner found,” unplug your scanner, 
shut down your computer, plug in your scanner, and then turn on your 
computer.

■ Make sure you have selected the correct image source (EPSON TWAIN L).

Scanner Problems

If the fluorescent lamp doesn’t come on . . .

■ Make sure the power cord is connected to the scanner and plugged in to a power 
outlet. 

■ This may also be due to the power saving function (sleep mode); if the scanner 
doesn’t receive any commands after ten minutes, it turns off the lamp. The lamp 
comes back on when you scan.

If the scanner doesn’t scan your image . . .

■ Check your scanner source setting. Make sure you selected EPSON TWAIN L.

■ Wait until the fluorescent lamp stays on (ready for scanning). You may need to 
preview your scan to make the lamp come on.

■ If there is more than one USB hub in use, try connecting the scanner directly to 
the computer’s USB port. Use only the USB cable that came with your scanner.
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If you see the message “Scanner Not Ready” (Windows 98) or “Cannot find the 
scanner on the bus” (Macintosh)” . . .

■ Make sure the scanner is plugged in. You may need to restart your computer after 
plugging in your scanner.

■ Make sure your scanner cable is securely connected. Then open and close the 
scanner monitoring utility to manually check for the scanner (see “Enabling 
Scanner Monitoring” in your EPSON TWAIN User’s Guide). If you still see the 
message, unplug your scanner, then plug it in again, and restart your system. 

■ To turn off scanner monitoring, see “Enabling Scanner Monitoring” in your 
EPSON TWAIN User’s Guide.

Software Problems

If you can’t open the EPSON TWAIN driver . . .

■ Check the USB cable connection. If necessary, restart your computer.

■ Check that your system recognizes your scanner. Check System Device Manager 
in the Windows Control Panel.

■ Check your scanner source setting. Make sure you selected EPSON TWAIN L.

If the scanner software doesn’t work properly . . .

■ Make sure your computer meets the system requirements listed on pages 3 and 4, 
and supports the software applications you are using.

■ Check your computer’s memory. See if the computer has enough memory for 
your software. If you’re running other software at the same time, using RAM 
resident programs, or have many device drivers, the computer may not have 
enough memory. (See your software and computer manuals.) If you are scanning 
a large image or scanning at a high resolution, your computer may not have 
enough memory to process the image.

■ Check your software installation. Make sure that your software is correctly 
installed and set up. If all else fails, uninstall your software, then reinstall it.
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If you need to reinstall your scanner software in Windows. . .

1. Click Start, point to Settings, then click Control Panel. Double-click the 
Scanners and Cameras icon.

2. Highlight EPSON Perfection 610 in the list of scanners and cameras.

3. Click Remove to remove your scanner software.

4. Insert your scanner CD-ROM in your CD-ROM drive.

5. Click Start and Run. At the prompt, type your CD-ROM drive letter and 
EPSON (for example: D:\EPSON).

6. On the Main Menu, select Reinstall Scanner Software.

7. On the Re-install screen, click the Reinstall button.

8. Click OK to restart your computer.

9. When your computer restarts, you see the Add New Hardware Wizard screen. 
Follow steps 3 through 8, starting on page 11, to install your scanner software.

If you need to reinstall your scanner software on a Macintosh . . . 

1. Insert your scanner CD-ROM in your CD-ROM drive.

2. Double-click the  EPSON icon.

3. On the Main Menu, select Reinstall Scanner Software.

4. On the Reinstall window, click the Reinstall button.

5. Read the next message, then click Yes.

6. On the TWAIN Installer screen, make sure Easy Install is selected for the default 
installation, then click Install.

7. After the installation is complete, click Restart. If necessary, calibrate your screen. 
Then your Macintosh automatically restarts.
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Scanning Problems

If the file size is too big . . . 

Adjust your scan settings. Try selecting a lower 
resolution (dpi), or scan only part of the image.

If your scanned image is faint or has gaps . . .

■ Check the brightness. Decrease the software or 
driver’s brightness setting.

■ Try adjusting the Gamma setting.

■ Check the condition of your original. If the 
document is damaged, dirty, or wrinkled, these 
imperfections will show up in your scan.
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If your scanned image is blurred or distorted . . .

■ Check the position and condition of your 
document. Make sure the document is placed flat 
against the scanner’s document table glass. If only 
part of the image is blurred, part of your document 
may be wrinkled or warped.

■ Make sure the document table glass is clean.

■ Make sure the scanner is not tilted or placed on an 
unstable or uneven surface.

If the edges of the document are not scanned . . .

■ Check the position of your source document. Adjust 
your document’s position so that the image is within 
the glass area.

■ Make sure your document is not too large for the 
readable area.
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If your image scans at an angle . . .

Check the position of your source document. It may 
be placed at an angle on the document table. Align it 
so the horizontal and vertical edges are carefully 
aligned with the scales on the top and side of the 
document table.

If your image is too dark . . .

Your software settings are not correct for your 
document type. Adjust the brightness and contrast with 
your application software.

If the image does not look the same as the original . . .

■ Check your software settings and make sure they are correct for your image type.

■ If the colors seem different from the original, try increasing your monitor’s color 
palette to 16 bit or 24 bit. Your software may also have insufficient color 
matching or color management capabilities.

■ Check to see if the image type is compatible with your software. 
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If colors are patchy or distorted at the edges of the image . . .

■ If the document is thick or warped at the edges, the scan may appear discolored 
from too much outside light. Try covering the edges of the document with paper 
to block outside light.

■ If the document is not placed flat against the scanner, discoloration may appear in 
the scanned image. Place the document flat and close the scanner cover.

If a line of dots is always missing from the scanned image . . .

■ If you are printing, your printer may be running out of ink or toner. For an 
EPSON ink jet printer, try cleaning the print heads as described in your 
documentation. If you are almost out of ink or toner, replace the cartridge.

■ If you see a missing line of dots on your screen as well as in printouts, your 
scanner may be malfunctioning. Consult your dealer.

If a line of dots always appears in the scanned image . . .

Check to see if the docuement table is dusty or scratched. Clean the document table 
glass as described on page 52.

If textured patterns of dots appear on areas of an image . . . 

Use the quality setting instead of the speed setting and check the Descreening option 
(when scanning from the Photo tab). The scanner will minimize the moiré patterns 
that may appear.

If colors on your monitor or printed page are different from those in the original 
image . . .

■ Increase your monitor’s color palette to 16 bit or 24 bit.

■ Check to see if your application has adequate color matching and management 
features, and if they are set up correctly.

■ Your monitor and printer use different technologies to represent colors, so the 
printed colors may not match the colors you see on the screen.
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If your printed image is larger or smaller than the original size . . .

You may have changed the resolution or scaled your image. Check the image size 
settings in your application to determine the actual size your image will be when it is 
printed.

If you cannot print your image or the printout is garbled . . .

■ Check the image size of your file to see if it is too large. Make sure that your 
computer has enough memory for your software. If there are many device drivers 
on your system, you are running multiple programs at the same time, or you have 
little free space on your hard drive, your computer may not have enough memory 
available. (See your software and computer documentation.)

■ Check that the printer is properly connected to the computer and is correctly set 
up. (See your printer manual.)

■ Check that your software is properly installed and set up for your printer. (See 
your software manual.)
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Where To Get Help

EPSON Technical Support

EPSON provides technical assistance through electronic support services and 
automated telephone services 24 hours a day. The following tables list the contact 
information:

Electronic support services

Service Access

World Wide Web From the Internet, you can reach EPSON’s Home Page at 
http://www.epson.com.

EPSON Internet FTP 
Site

If you have Internet FTP capability, use your Web browser (or 
other software for FTP downloading) to log onto 
ftp.epson.com with the user name anonymous and your 
e-mail address as the password.

EPSON Forum on 
CompuServe® 

Members of CompuServe can type GO EPSON at the menu 
prompt to reach the Epson America Forum. For a free 
introductory CompuServe membership, call (800) 848-8199 
and ask for representative #529.

Automated telephone services

Service Access

EPSON 
SoundAdviceSM

For pre-recorded answers to commonly asked questions about 
EPSON products 24 hours a day, seven days a week, call 
(800) 922-8911.

EPSON FaxAdviceTM Access EPSON’s technical information library by calling 
(800) 922-8911. You must provide a return fax number to use 
this service.

EPSON Referral 
Service

For the location of your nearest Authorized EPSON Reseller or 
Customer Care Center, call (800) 922-8911.

basics.book  Page 63  Wednesday, August 11, 1999  2:26 PM



64

To speak to a technical support representative, dial (310) 974-1970 (U.S.) or 
(905) 709-3839 (Canada), 6 AM to 6 PM, Pacific Time, Monday through Friday. Toll 
or long distance charges may apply. 

Before you call, please have the following information ready:

■ Product name (EPSON Perfection 610) 

■ Product serial number (located on the back of the scanner)

■ Computer configuration

■ Description of the problem

You can purchase genuine EPSON supplies and accessories from EPSON Accessories 
at (800) 873-7766 or visit our web site at www.epsonsupplies.com (U.S. sales only). 
In Canada, please call (800) 873-7766 for dealer referral.

If you need help using another manufacturer’s software with 
an EPSON product, see the documentation for that software 
for technical support information.

Software Technical Support

Software Telephone Fax Online and E-mail

EPSON TWAIN 
driver

US: 
(310) 974-1970
Canada: 
(905) 709-3839

(800) 922-8911 
fax-on-demand 
system

www.epson.com

PictureWorks 
HotShots

(925) 855-2009
Phone support 
is free for 30 
days from the 
day you register

— www.pictureworks.com

techsupport@pictureworks.com

NewSoft Presto! 
PageManager

(510) 445-8616 (510) 445-8601 www.newsoftinc.com

BrØderbund 
The Print Shop 
PressWriter

(423) 670-2032 (423) 670-2021 www.broderbund.com/support
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Scanner Specifications

This chapter includes specifications and safety approval information for the EPSON 
Perfection 610 scanner.

Specifications are subject to change without notice.

* The maximum hardware resolution of 600 × 2400 dpi is achieved using EPSON’s Micro Step 
Drive™ technology.

** The maximum hardware resolution for sub scans is 2400 dpi when the width of the document to 
be scanned does not exceed 4 inches. If the width exceeds 4 inches, the scanning software 
interpolates the resolution after 1200 dpi.

Scanner type Flatbed, color

Photoelectric device Color CCD line sensor

Effective pixels 5100 × 7020 pixels at 600 dpi, 100% scaling

Maximum document 
size

US letter or A4 size (8.5 inches × 11.7 inches [216 mm × 297 
mm]) 

Optical resolution 600 dpi

Maximum hardware 
resolution*

600 dpi (main scan) 
2400 (sub scan)**

Speed (600 dpi, draft 
mode)

Color: 8.1 msec/line
Monochrome (bi-level): 2.7 msec/line

Output resolution 75, 150, 300, 600, 1200, and 2400 dpi

Color separation RGB color filters on CCD

Reading sequence Monochrome: One-pass scanning
Color byte sequence: One-pass scanning (R, G, B)
Color line sequence: One-pass scanning (R, G, B)

Pixel depth 8 bits per pixel (12 bits per pixel input, 8 bits per pixel output)

Line art settings Fixed threshold

Gamma correction 1 type for user-defined

basics.book  Page 65  Wednesday, August 11, 1999  2:26 PM



66

Electrical

Check the label on the back of the scanner for voltage 
information.

Environmental

Temperature

Operation: 41 to 95 °F (5 to 35 °C)
Storage: –13 °F to 140 °F (–25 °C to 60 °C)

Interface USB (Type B receptacle connector)

Light source White cold cathode fluorescent lamp

Reliability 10,000 cycles of carriage movements (main unit MCBF)

Weight Approx. 9.9 lb (4.5 kg)

Dimensions Width: 11.3 inches (287 mm)
Depth: 16.7 inches (425 mm)
Height: 3.4 inches (88 mm)

Specification 100−120 V model 220−240 V model

Input voltage range AC 90 to 132 V AC 198 to 264 V

Rated frequency 50 to 60 Hz

Input frequency 49.5 to 60.5 Hz

Rated current 0.5 A 0.3 A

Power consumption Approximately 20W
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Humidity (without condensation)

Operation: 10% to 80%
Storage: 10% to 85%

Operating conditions

Ordinary office or home conditions; avoid extreme dust, operation under direct 
sunlight, and strong light sources.

Safety Approvals

120V model

Safety standards: UL 1950 with D3
CSA C22.2 No. 950

EMC FCC part 15 subpart B class B
CSA C108.8 class B

230V model

Safety standards: EN 60950
EMC EN 55022 (CISPR Pub 22) class B

AS/NZS 3548 class B
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CE marking

230 V model

Low Voltage Directive 73/23/EEC EN 60950
EMC Directive 89/336/EEC EN 55022 Class B

EN 61000-3-2
EN 61000-3-3
EN 50082-1

IEC 801-2
IEC 801-3
IEC 801-4

USB Interface

Interface type

Universal Serial Bus Specification Revision 1.0

Configuration

Element Description

Device Full Speed mode (12Mbit/s)

Configuration Characteristics: Self-powered

Remote wake up feature: Not supported

Maximum power consumption from VBUS: 2mA at 5V
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Electrical standard

Full Speed mode (12Mbit/s) of Universal Serial Bus Specification Revision 1.0. 

Connector type

One receptacle (series B)

Connector pin arrangement

Interface No alternate setting

Number of endpoints used by this interface 
(excluding endpoint 0): 2

Endpoint 1 Bulk IN transfer

Maximum data transfer size: 64 byte

Endpoint 2 Bulk OUT transfer

Maximum data transfer size: 64 byte

String Descriptor Language ID: US English

1: iManufacterer: “EPSON”

2: iProduct: “Perfection610”

Pin number Signal Connector

1 VCC

2 –DATA

3 +DATA

4 GND

Element Description
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Initialization Methods

The scanner can be initialized (returned to a fixed set of conditions) in the following 
ways:

Hardware 
initialization

■ The scanner is plugged in.

■ The USB cable is unplugged from the USB port on the 
scanner.

Software 
initialization

■ Software sends the ESC @ (initialize the scanner) 
command.

■ The scanner receives a Bus Reset from the USB interface.

basics.book  Page 70  Wednesday, August 11, 1999  2:26 PM



71

Index

A
Accessories, 64
Adobe Acrobat Reader, 19 to 20

B
Blurred image, 59

C
Cleaning the scanner, 52
Connecting the scanner to your computer, 

10

D
Document cover, removing, 29
Document position, 22, 59
Documentation, how to use, 2 to 3, 19 to 20

E
ENERGY STAR, 5
EPSON

Accessories, 64
help, 63 to 64

F
File size, 58

H
Help

EPSON, 63 to 64
software, 64

Home position, 9

I
Image quality problems, 58 to 60
Initialization, 70
Installing

creative software and electronic manuals, 
16 to 18

scanner software, 11 to 15

L
Lock, transportation, 9

M
Macintosh

installing software, 14 to 18
screen calibration, 15
system requirements, 4

Maintenance, 52
Manuals, viewing electronic, 19 to 20
Marquees, 26 to 27
Moving the scanner, 51

O
One-touch scanning, see Start button
Optical character recognition (OCR), 35

P
Photographs, scanning, 23 to 24
PictureWorks HotShots, 35
Power-on sequence, 10

basics.book  Page 71  Wednesday, August 11, 1999  2:26 PM



72

Presto! PageManager
OCR, 35
Start button scanning, 32 to 35

R
Removing document cover, 29
Resolution, choosing, 27

S
Safety approvals, 67 to 68
Safety instructions, 5 to 6
Scanner

on/off, 10
specifications, 65 to 70

Scanning, 22 to 27
instructions, 21 to 24
with Start button, 32 to 36

Screen calibration
Macintosh, 15
Windows 98, 13

Service, 63 to 64
Settings for scan, selecting, 24 to 25
Setup problems, 55
Sleep mode, 10
Software installation

Macintosh, 14 to 18
Windows, 11 to 13, 16 to 18

Software problems, 56 to 57
Space requirements, 8
Specifications, 65 to 70
Start button

preparing to use, 31
scanning with, 32 to 36

Support, 63 to 64
System requirements, 3 to 5

T
Technical support, 63 to 64
Thick documents, 29
Transportation lock, 9
Transporting the scanner, 51
Troubleshooting

image quality, 58 to 60
scanner, 55 to 56
setup, 55
software, 56 to 57

U
Unlocking the scanner, 9
Unpacking the scanner, 7
USB, 3, 4, 68 to 69

V
Viewing electronic manuals, 19 to 20

W
Windows

installing software, 11 to 13, 16 to 18
screen calibration, 13
system requirements, 3

World Wide Web, 63, 64

Y
Year 2000, 5
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio or television 
reception. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause interference to radio and television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures.

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

■ Consult the dealer or an experienced radio/TV technician for help.

Warning

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the FCC for 
this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this 
device. If this equipment has more than one interface connector, do not leave cables connected to unused 
interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to 
operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le materiel brouilleur du 
Canada.
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DECLARATION of CONFORMITY
According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or CPU Boards and 
Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC. 

Located at: 20770 Madrona Avenue
MS: B2-11
Torrance, CA 90503
Telephone : (310) 782-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the 
FCC rules as a Class B digital device. Each product marketed, is identical to the representative unit tested and 
found to be compliant with the standards. Records maintained continue to reflect the equipment being produced 
can be expected to  be within the variation accepted, due to quantity production and testing on a statistical basis as 
required by 47CFR §2.909 Operation is subject to the following two conditions: (1) this device may not cause 
harmful interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation.

Trade Name: EPSON

Type of Product: Scanner

Model: G750A
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EPSON AMERICA, INC.

LIMITED WARRANTY

What Is Covered: Epson America, Inc. (“Epson”) warrants to the first end user customer of the Epson product enclosed with this 
limited warranty statement, that the product if purchased and used in the United States or Canada, conforms to the 
manufacturer’s specifications and will be free from defects in workmanship and materials for a period of one year from the date of 
original purchase. 

What Epson Will Do To Correct Problems: Should your EPSON product prove defective during the warranty period, please bring 
the product securely packaged in its original container or an equivalent, along with proof of the date of original purchase, to your 
Epson Dealer or Epson Customer Care Center. Epson will, at its option, repair or replace on an exchange basis the defective unit, 
without charge for parts or labor. When warranty service involves the exchange of the product or of a part, the item replaced 
becomes Epson property. The exchanged product or part may be new or previously repaired to the Epson standard of quality. 
Exchange or replacement products or parts assume the remaining warranty period of the product covered by this limited 
warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. This warranty does 
not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This 
warranty does not cover third party parts, components or peripheral devices added to the Epson product after its shipment from 
Epson, e.g., dealer-added boards, chips or drives. Epson is not responsible for warranty service should the Epson label or logo or 
the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a 
result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and 
lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an 
Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced in service, you will be held responsible for costs 
incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS 
OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED 
WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, 
ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID.  IN THE 
EVENT THE REMEDIES ABOVE FAIL, EPSON’S ENTIRE LIABILITY SHALL BE LIMITED TO A REFUND OF THE 
PRICE PAID FOR THE EPSON PRODUCT COVERED BY THIS LIMITED WARRANTY. EXCEPT AS PROVIDED 
IN THIS WRITTEN WARRANTY, NEITHER EPSON  NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, 
INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER 
RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts and some jurisdictions do not allow the 
exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you.

This warranty gives you specific legal rights, and you may also have other rights which vary from jurisdiction to jurisdiction.

To locate the Epson Authorized Dealer or Epson Customer Care Center nearest you call: 

800-922-8911  or write to:

Epson America, Inc.   ●   P.O. Box 2842   ●   Torrance, CA 90509-2842   ●   MS:CS1
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